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Overview 
This reference guide describes the specifications, circuits, circuit patterns, usage, and operation 

of the pulse sensor using the low-noise operational amplifier TC75S67TU (hereinafter, this sensor). 

This sensor is used a microcontroller and configured to display the operation control and 

measurement status on a PC. Please refer when designing pulse sensors using TC75S67TU. 
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1. Introduction 

The pulse sensor described in this reference guide is a reflective pulse sensor using an light sensor 

SFH7051 manufactured by OSRAM Corporation as a sensor device. The sensor unit, which detects 

the amount of light reflected in the living body, and the amplifier unit, which amplifies the output 

signal from the sensor unit, are separate boards. The sensor unit is made of a flexible board for 

consideration of wearable applications in which the sensor unit is brought into direct contact with 

the living body. 

The sensor and amplifier are connected by a three-wire cable, and the signal from the sensor is 

amplified by the amplifier and output to the microcontroller. In the document, the microcontroller is 

the Arduino, and it controls the operation of this sensor and display the results on the PC. Since the 

power supply also uses a 5 V DC voltage supplied from the Arduino, it can be used as a pulse sensor 

if there is the Arduino and a personal computer in addition to this sensor. 

 

Various information on this sensor reference design is provided from here → 

 

Components other than Op-amps are also surface-mounted, and the sensor section is 30 mmφ 

and the amplifier section is 20 mm×20 mm, making the circuit board compact and easy to use. 

Note that the circuit and board pattern prepared in the reference design of the pulse sensor 

described in this guide are provided with jumpers and lands for unmounted elements in consideration 

of scalability such as changing the bias voltage of the Op-amp. In circuit diagrams and bill of 

materials, jumpers are written as 0 Ω, and unmounted elements are written as "Not mounted". Also, 

the wiring on the circuit diagram is indicated by a dotted line. 

  

Click Here 

https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
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2. Specifications and appearance of the pulse sensor 

2.1. Pulse sensor specifications 

Table 2.1 Specifications of the pulse sensors 

Item Specifications 

I/F Arduino connections 

Control method Control from Arduino and Shield connected PCs 

Power supply voltage 5 V supplied from Arduino and Shield board 

Onboard pulse sensor OSRAM Co., Ltd.'s SFH7051 

Emission wavelength 530nm 

On-board Op-amp 
TC75S67TU manufactured by Toshiba Devices & 

Storage Co., Ltd. 

 

2.2. Feature 

<Entire> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2.1 Pulse sensor 
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<Sensor circuit> 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2.2 Sensor circuit (Flexible board) 

 

<Amplifier circuit> 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2.3 Amplifier circuit (Rigid board) 
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3. Circuit and board pattern of the pulse sensor 

3.1. Circuit diagrams 

<Sensor circuit> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.1 Sensor circuit diagram 

<Amplifier circuit> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.2 Amplifier circuit diagram 
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3.2. Bill of materials (sensor circuit) 

Table 3.1 Bill of Materials (Sensor circuit) 

Item Part 
Qua

ntity 
Value Part name 

Manufac

turer 
Description 

Package 

Name 

Standard 

dimension 

Mm (inch) 

Comments 

1 U1 1 - SFH7051 OSRAM Photo sensor 
 

4.7×2.5×0.9  

2 U2 1 - TC75S67TU TOSHIBA 
Operational 

amplifier 
SOT-353F 2.0×2.1×0.7  

3 C1, C6 2 10 μF   
Ceramic 

25 V, ±10 % 
 

2.0×1.2 

(0805) 
 

4 C2 1 3.3 nF   
Ceramic 

50 V, ±10 % 
 

1.0×0.5 

(0402) 
 

5 C3 1 1 μF   
Ceramic 

6.3 V, ±10 % 
 

1.0×0.5 

(0402) 
 

6 C4 1 10 nF   
Ceramic 

25 V, ±10 % 
 

1.0×0.5 

(0402) 
 

7 C5 1 100 nF   
Ceramic 

16 V, ±10 % 
 

1.0×0.5 

(0402) 
 

8 C7 1      
2.0×1.2 

(0805) 

Not mounted 

Operational 

amplifier 

For changing 

the bias 

9 
R1, R2, R3, 

R7 
4 1 kΩ   100 mW, ±1 %  

1.0×0.5 

(0402) 
 

10 R4 1 22 Ω   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

11 R5 1 470 kΩ   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

12 R6 1 100 Ω   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

13 R8, R9 1 0 Ω   1 A  
1.0×0.5 

(0402) 
 

14 R10, R11 2      
1.0×0.5 

(0402) 

Not mounted 

Operational 

amplifier 

For changing 

the bias 
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3.3. Bill of materials (amplifier circuit) 

Table 3.2 Bill of Materials (Amplifier circuit) 

Item Part 
Qua

ntity 
Value Part name Manufacturer Description 

Package 

Name 

Standard 

dimension 

Mm (inch) 

Comments 

1 U1 1 - TC75S67TU TOSHIBA 
Operational 

amplifier 
SOT-353F 2.0×2.1×0.7  

2 U2 1 - TC75S54FU TOSHIBA 
Operational 

amplifier 
SOT-353 2.0×2.1×0.9  

3 C1 1 150 nF   
Ceramic 

6.3 V, ±10 % 
 

1.0×0.5 

(0402) 
 

4 C2 1 1 μF   
Ceramic 

6.3 V, ±10 % 
 

1.0×0.5 

(0402) 
 

5 C3 1 100 μF   
Ceramic 

6.3 V, ±10 % 
 

3.2×1.6 

(1206) 
 

6 C4, C8 2 10 nF   
Ceramic 

25 V, ±10 % 
 

1.0×0.5 

(0402) 
 

7 C5, C7 2 100 nF   
Ceramic 

16 V, ±10 % 
 

1.0×0.5 

(0402) 
 

8 C6 1 10 μF   
Ceramic 

25 V, ±10 % 
 

2.0×1.2 

(0805) 
 

9 R1, R5 2 10 kΩ   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

10 R2, R4 2      
1.0×0.5 

(0402) 

Not mounted 

Reference 

voltage 

For change 

11 R3 1 0 Ω   1 A  
1.0×0.5 

(0402) 
 

12 R6 1 100 Ω   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

13 R7, R8 2 1 kΩ   100 mW, ±1 %  
1.0×0.5 

(0402) 
 

14 CN1 1 - B3B-ZR JST 
Connector 

3 pin/straight 
 6×4.5×3.5  

15 CN2 1 - 110990030 Seeed Studio 
Grove connector 

4 pin/straight 
 10×5.1×8.1  
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3.4. Board pattern drawing (flexible board) 

A reinforcing plate is provided on the flexible board to prevent damage during mounting. 

<Front (part mounting side)> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.3 Front surface pattern 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.4 Front surface reinforcement plate 
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Fig. 3.5 Front surface silk 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.6 Front surface solder 
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Fig. 3.7 Front surface paste 
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<Back> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.8 Back surface pattern 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.9 Back surface reinforcement plate 
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Fig. 3.10 Back surface pattern silk 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.11 Back surface pattern solder 
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3.5. Board pattern drawing (rigid board) 

<Front (part mounting side)> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.12 Front surface pattern 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.13 Front surface silk 
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Fig. 3.14 Front surface solder 
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Back 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.15 Back surface pattern 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.16 Back surface silk 
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Fig. 3.17 Back surface solder 
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4. Operation procedure 

4.1. About Arduino and Processing 

The Arduino is a palm-sized one-board microcontroller. The microcontroller is selected as the 

control microcontroller for this reference design because it is generally available on the market and 

can be easily obtained, and if the program is transferred once, the sensor can be operated without 

a PC. Use the Processing to display the measured results on the PC-screen. 

This reference design provides Arduino operating program and a Processing program that displays 

the status of measurements. To run this program, you must install Arduino IDE and Processing 3 on 

your PCs. Furthermore, In the case of pulse sensor, it is necessary to include library “MsTimer2” at 

Arduino IDE. Both software and library are available free of charge on their official sites. Download 

the software and install it on your PC in advance. These software are also needed to edit each 

program. These programs are called "sketches" in Arduino, Processing. 

 Moreover, in the case of Windows10, a display window for result of Processing may not start. In 

such a case, it is necessary to change the configuration file of initial value that generated 

automatically at the first time start-up of Processing. Since a solution change with PCs, please 

implement a suitable solution with reference to Web etc. 

 Refer to the Commercial Instructions for more information on Arduino and Processing. 

 

4.2. Connecting to the Arduino 

Fig. 4.1 shows the connections to the Arduino. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.1 Connections to the Arduino 

The Arduino is used in conjunction with ”seeed studio Base Shield”. The connection port of the 

base shield to the sensor is connected A1 terminal. Connect the base shield and the PC with a USB 

cable. 

 

To the PC 
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4.3. Start and stop 

When the compressed file "RD159-SKETCH-01_E.zip" of the sketch prepared for this sensor is 

downloaded from the following link and decompressed in an appropriate place on the PC, the folder 

containing the two files "PW_sensor_Arduino" and "PulseWave_sensor.pde" and the usage 

convention is created. Save the file as is. 

 To download sketches → 

Start the Arduino IDE and select File → Open to open the saved PW_sensor_Arduino.ino file. The 

window shown on the left of Fig. 4.2 opens separately from the window opened at startup. Select 

Sketch → Write to the microcontroller board to start compiling the files and write the sketch to the 

Arduino after compiling. When writing is completed successfully, a message appears at the bottom 

of the window. The Arduino is now ready. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.2 Arduino IDE window 

Click Here 

https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
https://toshiba.semicon-storage.com/ap-en/design-support/referencedesign/low-noise-op-amp-tc75S67tu-for-pulse-sensor_MotorControl_RD159.html
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Then start the Processing 3. When you start the Processing 3, the window shown in Fig. 4.3 opens. 

Click Get Started at the bottom right of the child window. Then, select File → Open to open the saved 

PulseWave_sensor.pde file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.3 Start-up window of Processing 3 

The window shown in Figure 4.4 opens separately from the window opened at startup. Click the 

Operation button (red circle) to open the result display window and start the measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.4 Processing Measurement Start window 

Click the stop button (red circle in Fig. 4.5) on this screen to finish the measurement. The Result 

View window closes and the measurement ends. Then close the open windows sequentially. 
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Fig. 4.5 Processing Measurement Completion window 

You can pause the measurement by clicking on the result display window while the measurement 

is being performed. At this time, the result display window is not closed and the measurement 

waveform remains stopped. To restart the measurement, click on the window again. 

 

4.4. Precautions for measurement 

 Optical sensors that detect and sense the light used in this guide are affected by disturbance 

light. For this reason, it is necessary to reduce the influence of disturbance light in 

environments such as outdoors and indoor fluorescent lights in clear weather. The sensor 

should be covered with a cover or housed in a housing to prevent the entry of disturbance 

light. 

 

 Differences in blood vessels between individuals and their physical condition may make 

measurements inadequate. If this is the case, try at different locations and measure at the 

site where the best results are obtained. 
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5. Pulse measurement 

The actual pulse measurement and the measurement status are shown below. The flexible circuit 

board and rigid circuit board described in this guide were housed in a special housing and used as a 

pulse measurement set for demonstration. Fig. 5.1 and Fig. 5.2 show the appearance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Figure 5.1  Front view of demonstration   Figure 5.2  Flexible board portion in 

pulse measurement set                     demonstration set 

 

Fig. 5.1 shows a front view of the demonstration pulse measurement set. This set is designed to 

measure the pulse with the fingertip and is measured by placing the finger in the central green-

shining hole (the area enclosed by the yellow dotted circle). The green light is the light of the LEDs 

of the sensor. 

Fig. 5.2 shows an enlargement of this hole, but it is made of transparent resin so that the mounting 

position of the flexible printed circuit board can be seen. In the actual set, this part is made of black 

resin to block light. 

  

Flexible substrate 

Rigid substrate 
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Fig. 5.3 Example of Pulse Sensor Measurement 

 

Fig. 5.3 shows an example of actual pulse measurement using this set. This set is measured with 

fingertips, but it can also be measured at other parts of the body, such as the wrist, with a different 

housing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.2 Waveform of Pulse Sensor Measurement status 

  

Figure 5.4 shows an example of the results display screen. The blue line is the measured actual 

pulse wave, and the red line is the pulse wave that is filtered and shaped for measurement. The 

pulse rate is converted to a one-minute number from the period of this waveform and displayed in 

the upper part of the Measure window as the BPM (Beats Per Minute) value. 

  

Measured 1 minute pulse rate 
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Terms of Use 
 
This terms of use is made between Toshiba Electronic Devices and Storage Corporation (“We”) and customers who 

use documents and data that are consulted to design electronics applications on which our semiconductor devices 

are mounted (“this Reference Design”). Customers shall comply with this terms of use. Please note that it is assumed 

that customers agree to any and all this terms of use if customers download this Reference Design. We may, at its 

sole and exclusive discretion, change, alter, modify, add, and/or remove any part of this terms of use at any time 

without any prior notice. We may terminate this terms of use at any time and for any reason. Upon termination of 

this terms of use, customers shall destroy this Reference Design. In the event of any breach thereof by customers, 

customers shall destroy this Reference Design, and furnish us a written confirmation to prove such destruction. 

 

1. Restrictions on usage 

1. This Reference Design is provided solely as reference data for designing electronics applications. Customers shall 

not use this Reference Design for any other purpose, including without limitation, verification of reliability. 

2. This Reference Design is for customer's own use and not for sale, lease or other transfer. 

3. Customers shall not use this Reference Design for evaluation in high or low temperature, high humidity, or high 

electromagnetic environments. 

4. This Reference Design shall not be used for or incorporated into any products or systems whose manufacture, 

use, or sale is prohibited under any applicable laws or regulations. 

 

2. Limitations 

1. We reserve the right to make changes to this Reference Design without notice. 

2. This Reference Design should be treated as a reference only. We are not responsible for any incorrect or 

incomplete data and information. 

3. Semiconductor devices can malfunction or fail. When designing electronics applications by referring to this 

Reference Design, customers are responsible for complying with safety standards and for providing adequate designs 

and safeguards for their hardware, software and systems which minimize risk and avoid situations in which a 

malfunction or failure of semiconductor devices could cause loss of human life, bodily injury or damage to property, 

including data loss or corruption. Customers must also refer to and comply with the latest versions of all relevant our 

information, including without limitation, specifications, data sheets and application notes for semiconductor devices, 

as well as the precautions and conditions set forth in the "Semiconductor Reliability Handbook". 

4. When designing electronics applications by referring to this Reference Design, customers must evaluate the whole 

system adequately. Customers are solely responsible for all aspects of their own product design or applications. WE 

ASSUME NO LIABILITY FOR CUSTOMERS' PRODUCT DESIGN OR APPLICATIONS. 

5. No responsibility is assumed by us for any infringement of patents or any other intellectual property rights of 

third parties that may result from the use of this Reference Design. No license to any intellectual property right is 

granted by this terms of use, whether express or implied, by estoppel or otherwise. 

6. THIS REFERENCE DESIGN IS PROVIDED "AS IS". WE (a) ASSUME NO LIABILITY WHATSOEVER, INCLUDING 

WITHOUT LIMITATION, INDIRECT, CONSEQUENTIAL, SPECIAL, OR INCIDENTAL DAMAGES OR LOSS, INCLUDING 

WITHOUT LIMITATION, LOSS OF PROFITS, LOSS OF OPPORTUNITIES, BUSINESS INTERRUPTION AND LOSS OF 

DATA, AND (b) DISCLAIM ANY AND ALL EXPRESS OR IMPLIED WARRANTIES AND CONDITIONS RELATED TO THIS 

REFERENCE DESIGN, INCLUDING WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE, ACCURACY OF INFORMATION, OR NONINFRINGEMENT. 

 

3. Export Control 

Customers shall not use or otherwise make available this Reference Design for any military purposes, including 

without limitation, for the design, development, use, stockpiling or manufacturing of nuclear, chemical, or biological 

weapons or missile technology products (mass destruction weapons). This Reference Design may be controlled under 

the applicable export laws and regulations including, without limitation, the Japanese Foreign Exchange and Foreign 

Trade Law and the U.S. Export Administration Regulations. Export and re-export of this Reference Design are strictly 

prohibited except in compliance with all applicable export laws and regulations. 

 

4. Governing Laws 

This terms of use shall be governed and construed by laws of Japan. 

 

 

 


